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Safety Notices

 A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or the 
like that, if not correctly performed or 
adhered to, could result in personal 
injury or death. Do not proceed 
beyond a WARNING notice until the 
indicated conditions are fully 
understood and met.

A CAUTION notice denotes a hazard. It 
calls attention to an operating procedure, 
practice, or the like that, if not correctly 
performed or adhered to, could result in 
damage to the product or loss of important 
data. Do not proceed beyond a CAUTION 
notice until the indicated conditions are 
fully understood and met.
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• Equipment — Direct Drive Robot 
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Name and address of the person established in the Community authorized to compile the technical file or 
the relevant technical documents: 
 
Ian Cowans 
Agilent Technologies UK Ltd 
The Crossing 
Haugh Head 
Wooler NTHU NE71 6QS 
UK 
Cell: +44 (7825) 241062 
 

 
___________________  Santa Clara, CA  December 18th, 2009 
Bob Srinivas 
Quality Manager     
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• “Accessing Automation Solutions user guides” on page x
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Preface
About this guide
About this guide

Who should read this guide

This guide is for people with the following job roles:

 

Installers, integrations, lab managers, and administrators are users who must 
have technical expertise. In addition, lab managers and administrators are 
individuals or groups responsible for the use and maintenance of the Direct 
Drive Robot and for ensuring that operators are adequately trained.

What this guide covers

This guide describes the following:

• Potential safety hazards of the Direct Drive Robot and how to avoid them.

• Specifications and site requirements for the Direct Drive Robot. Use this 
information to plan the space for the Direct Drive Robot. Make sure your 
site meets the requirements outlined in this guide before installing the 
robot.

                                                        

Job role Responsibilities

Installer Unpacks, installs, and tests the Direct Drive Robot before it 
is used.

Integrator Writes software and configures hardware controlled by the 
VWorks software.

Lab manager, 
administrator, 
or technician

• Manages the automation system containing the Direct 
Drive Robot

• Develops the applications that are run on the system

• Develops training materials and standard operating 
procedures for operators

Operator Performs the daily production work on the system that 
contains the Direct Drive Robot.
viii Direct Drive Robot Site Preparation and Safety Guide
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About this guide
Related guides

The Direct Drive Robot Site Preparation and Safety Guide should be used in 
conjunction with the following user documents:

• Direct Drive Robot User Guide. Explains how to set up and operate the 
Direct Drive Robot.

• VWorks Automation Control Setup Guide. Explains how to define labware, 
track labware, and manage users.

• VWorks Automation Control User Guide. Explains how to add devices, 
create protocols, and set task parameters for each device in the system.

• VWorks Software Quick Start. Provides an overview of how to use the 
VWorks Automation Control software.

• Automation Solutions device user guides. Explain how to set up and use 
the Automation Solutions devices.

• Third- party device user documents. Explain how to set up and use the 
third- party devices.

Related topics

For information about... See...

Accessing related user guides “Accessing Automation Solutions user 
guides” on page x

Using the knowledge base “Using the knowledge base” on page x

Reporting problems “Reporting problems” on page xiii
ixDirect Drive Robot Site Preparation and Safety Guide

http://www.chem.agilent.com/Library/usermanuals/Public/G5415-90004_VWorksQS_EN.pdf


Preface
Accessing Automation Solutions user guides
Accessing Automation Solutions user guides

About this topic

This topic describes the different formats of Automation Solutions user 
information and explains how to access the user information.

Where to find user information

The Automation Solutions user information is available in the following 
locations:

• Knowledge base. The help system that contains information about all of the 
Automation Solutions products is available from the Help menu within the 
VWorks software. 

• PDF files. The PDF files of the user guides are installed with the VWorks 
software and are on the software CD that is supplied with the product. A 
PDF viewer is required to open a user guide in PDF format. You can 
download a free PDF viewer from the internet. For information about using 
PDF documents, see the user documentation for the PDF viewer.

• Agilent Technologies website. You can search the online knowledge base or 
download the latest version of any PDF file from the Agilent Technologies 
website at www.agilent.com/lifesciences/automation. 

Accessing safety information

Safety information for the Agilent Technologies devices appears in the 
corresponding device user guide.

You can also search the knowledge base or the PDF files for safety information.

Using the knowledge base

Knowledge base topics are displayed using web browser software such as 
Microsoft Internet Explorer and Mozilla Firefox.

Note: If you want to use Internet Explorer to display the topics, you might 
have to allow local files to run active content (scripts and ActiveX controls). To 
do this, in Internet Explorer, open the Internet Options dialog box. Click the 
Advanced tab, locate the Security section, and select Allow active content to run in 
files on my computer.

To open the knowledge base, do one of the following:

• From within VWorks software, select Help > Knowledge Base or press F1.

• From the Windows desktop, select Start > All Programs > Agilent Technologies > 
VWorks > User Guides > Knowledge Base.
x Direct Drive Robot Site Preparation and Safety Guide
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Accessing Automation Solutions user guides
Opening the help topic for an area in the VWorks window

To access the context-sensitive help feature:

1 In the main window of the VWorks software, click the help button . 

The pointer changes to . Notice that the different icons or areas are 
highlighted as you move the pointer over them.

2 Click an icon or area of interest. The relevant topic or document opens. 
xiDirect Drive Robot Site Preparation and Safety Guide
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Accessing Automation Solutions user guides
Features in the Knowledge Base window

 

Item Feature

1 Navigation area. Consists of four tabs:

• Contents. Lists all the books and the table of contents of the 
books.

• Index. Displays the index entries of all of the books.

• Search. Allows you search the Knowledge Base (all products) 
using keywords. You can narrow the search by product.

• Favorites. Contains bookmarks you have created.

2 Navigation buttons. Enable you to navigate through the next or 
previous topics listed in the Contents tab.

3 Content area. Displays the selected online help topic.

4 Toolbar buttons. Enable you to print the topic or send documentation 
feedback by email.
xii Direct Drive Robot Site Preparation and Safety Guide
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Reporting problems
Related topics

Reporting problems

Contacting Automation Solutions Technical Support 

If you find a problem with the Direct Drive Robot, contact Automation 
Solutions Technical Support at one of the following:

Europe

Phone: +44 (0)1763850230

email: euroservice.automation@agilent.com

US and rest of world

Phone: 1.800.979.4811 (US only) or +1.408.345.8011

email: service.automation@agilent.com

Note: You can also send a software bug report from within the VWorks 
software.

Reporting hardware problems

When contacting Agilent Technologies, make sure you have the serial number 
of the device ready.

Reporting software problems

When you contact Automation Solutions Technical Support, make sure you 
provide the following:

• Short description of the problem

• Software version number

• Error message text (or screen capture of the error message dialog box)

• Screen capture of the About VWorks software dialog box.

• Relevant software files

To find the VWorks software version number:
In the VWorks software, select Help > About VWorks.

For information about... See...

Who should read this guide “Who should read this guide” on 
page viii

What this guide covers “What this guide covers” on 
page viii

Reporting problems “Reporting problems” on page xiii
xiiiDirect Drive Robot Site Preparation and Safety Guide
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Preface
Reporting problems
To find the Diagnostics software version number:

1 Open Diagnostics.

2 Read the version number on the title bar of the diagnostics window.

To send compressed protocol and associated files in VZP format:

In the VWorks software, select File > Export to export and compress the 
following files:

• Protocol file

• Device file (includes the device profile and teachpoint file)

• Labware definitions

• Liquid classes

• Pipette techniques

• Hit- picking files

• Plate map files

• Barcode files

• Error library

• Log files

• Form file (*.VWForm)

Reporting user guide problems

If you find a problem with this user guide or have suggestions for 
improvement, send your comments using one of the following methods:

• Click the feedback button ( ) in the online help.

• Send an email to documentation.automation@agilent.com.
 

Related topics

For information about... See...

Who should read this guide “Who should read this guide” on 
page viii

What this guide covers “What this guide covers” on 
page viii

Accessing user information “Where to find user information” 
on page x

Using the knowledge base “Using the knowledge base” on 
page x
xiv Direct Drive Robot Site Preparation and Safety Guide
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1
Safety

This chapter contains the following topics:

• “General safety information” on page 2

• “Safety and regulatory certifications” on page 3

• “Emergency stop” on page 5

• “High- force hazards” on page 6

• “Mechanical hazards” on page 7

• “Electrical hazards” on page 9
1
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1   Safety
General safety information
General safety information

Before installing and using the Direct Drive Robot

The Direct Drive Robot is designed for safe operation. When the Direct Drive 
Robot is installed correctly, you are protected from moving parts and 
hazardous voltage. However, you must be aware of the potential hazards and 
understand how to avoid being exposed to them.

Before installing and using the Direct Drive Robot, make sure you are properly 
trained in the correct and safe installation and operation of the robot.

EU installations only. Be aware that the Direct Drive Robot is considered 
incomplete machinery and must be installed to comply with the essential 
health and safety requirements (EHSRs) of the Machinery Directive 
2006/42/EC.

Intended product use

Agilent Technologies products must only be used in the manner described in 
the Agilent Technologies product user guides. Any other use may result in 
damage to the product or personal injury. Agilent Technologies is not 
responsible for any damages caused, in whole or in part, by improper use of 
the products, unauthorized alterations, adjustments or modifications to the 
products, failure to comply with procedures in Agilent Technologies product 
user guides, or use of the products in violation of applicable laws, rules or 
regulations. Except as otherwise expressly provided in Agilent Technologies 
product user guides, any alteration, adjustment or modification to the products 
will void the product warranty.

The Direct Drive Robot is not intended or approved for diagnosis of disease in 
humans or animals. You assume full responsibility for obtaining any regulatory 
approvals required for such use and assume all liability in connection 
therewith.

Related information

WARNING  Do not remove the Direct Drive Robot exterior covers or otherwise 
disassemble the robot. Doing so can cause injuries and damage the Direct Drive Robot.

For information about... See...

Safety and regulatory certifications “Safety and regulatory certifications” on 
page 3

Emergency stop “Emergency stop” on page 5

High- force hazards “High- force hazards” on page 6

Mechanical hazards “Mechanical hazards” on page 7

Electrical hazards “Electrical hazards” on page 9
2 Direct Drive Robot Site Preparation and Safety Guide



1   Safety
Safety and regulatory certifications
Safety and regulatory compliance

Compliance standards

See Declaration of Conformity and Declaration of Incorporation for details.

Electromagnetic compatibility
If the robot causes interference with radio or television reception, which can 
be determined by turning the robot off and on, try one or more of the 
following measures:

• Relocate the radio or television antenna.

• Move the device away from the radio or television.

• Plug the device into a different electrical outlet, so that the device and the 
radio or television is on separate electrical circuits.

• Make sure that all peripheral devices are also certified.

• Make sure that appropriate cables are used to connect the device to 
peripheral equipment.

• Consult your equipment dealer, Agilent Technologies, or an experienced 
technician for assistance.

• Changes or modifications not expressly approved by Agilent Technologies 
could void the user's authority to operate the equipment.

Sound emission declaration
Sound pressure: Lp < 70 dB according to EN 27779:1991.

Schalldruckpegel: LP < 70 dB nach EN 27779:1991.

CE marking Standard

EMC Directive 2004/10/EC

EMC IEC 61326- 1:2005 / EN 61326- 1:2006

EM Emissions CISPR 11:2004 / EN 55011:2007 (Class A)

Low Voltage Directive 2006/95/EC

Safety IEC 61010- 1:2001 / EN61010- 1:2001

EMC

Canada ICES- 001:2004

Australia/New Zealand AS/NZS CISPR 11:2002

CSA/Safety

Canada CAN/CSA- C22.2 No. 61010- 1- 04

USA ANSI/UL 61010- 1:2004
3Direct Drive Robot Site Preparation and Safety Guide



1   Safety
Safety and regulatory certifications
Symbols

Warnings in the user documentation or on the instrument must be observed 
during all phases of operation, service, and repair of this instrument. Failure 
to comply with these precautions violates safety standards of design and the 
intended use of the product. Agilent Technologies assumes no liability for the 
customer’s failure to comply with these requirements.

Related information

Symbol Description

 See accompanying instructions for more information.

 Indicates hazardous voltages.

 Indicates pinch, crush, and cut hazard.

 Indicates that you must not discard this electrical/
electronic product in domestic household waste.

For information about... See...

General safety information “General safety information” on page 2

Emergency stop “Emergency stop” on page 5

High- force hazards “High- force hazards” on page 6

Mechanical hazards “Mechanical hazards” on page 7

Electrical hazards “Electrical hazards” on page 9
4 Direct Drive Robot Site Preparation and Safety Guide



1   Safety
Emergency stop
Emergency stop

Emergency stop pendant

The Direct Drive Robot is equipped with an emergency stop pendant. Pressing 
the red button on the pendant cuts power to the robot motors and stops the 
robot during an emergency.

If the robot is integrated with other devices in a system, Agilent Technologies 
recommends that you install a main emergency stop button to cut power to the 
robot and all devices simultaneously.

Figure Emergency stop pendant.

Related information

For information about... See...

General safety information “General safety information” on page 2

Safety and regulatory certification “Safety and regulatory certifications” on 
page 3

High- force hazards “High- force hazards” on page 6

Mechanical hazards “Mechanical hazards” on page 7

Electrical hazards “Electrical hazards” on page 9
5Direct Drive Robot Site Preparation and Safety Guide



1   Safety
High-force hazards
High-force hazards

Direct Drive Robot inertia

The Direct Drive Robot has relatively low inertia and is designed to stop its 
movement when it comes in contact with an obstacle. However, you can be 
injured if you obstruct the robot while it is in motion. 

Agilent Technologies highly recommends that you install the robot inside an 
enclosure. Safety- interlocked doors or light curtains that stops the robot when 
opened or interrupted can be used to further mitigate risk. Make sure the 
safety- interlocked enclosure complies with your country's safety regulations.

EU installations only. The enclosure and other safety recommendations are 
required so that the Direct Drive Robot installation is compliant with the 
provisions of the Machinery Directive 2006/42/EC.

Related information

For information about... See...

General safety information “General safety information” on page 2

Safety and regulatory certification “Safety and regulatory certifications” on 
page 3

Emergency stop “Emergency stop” on page 5

Mechanical hazards “Mechanical hazards” on page 7

Electrical hazards “Electrical hazards” on page 9
6 Direct Drive Robot Site Preparation and Safety Guide



1   Safety
Mechanical hazards
Mechanical hazards

Moving-parts hazards

The following diagram shows the robot’s maximum radial and vertical reach. 
The radial reach includes a typical microplate held in portrait orientation.

Figure Direct Drive Robot radial (top view) and vertical reach (side view).

                                                        

WARNING  Keep clear of the robot’s reach when it is in motion. Keep your fingers, hair, 
clothing, and jewelry away from the robot while it is in motion.

WARNING The robot does not always move in a straight line between teachpoints. Do 
not try to predict the robot’s movements and reach into the robot’s travel space while it is 
in operation.

A
1

77 cm

7.9 cm

44.2 cm
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1   Safety
Mechanical hazards
Pinch hazards

The Direct Drive Robot has four axes of motion:

Puncture hazards

The tapered robot grippers and the robot’s low inertia are features that are 
designed to prevent puncture or other injuries. However, you can be injured if 
you obstruct the robot while it is in motion.

                                                        

1

2

3

4

Item Axis Description of robot movement

1 Waist Robot arm rotates infinitely about the waist.

2 Elbow Robot forearm rotates infinitely about the elbow.

3 Wrist Robot hand rotates infinitely about the wrist.

4 Mast Robot arm moves up and down along the mast.

WARNING Keep clear of the robot while it is in motion. The robot could pinch or bruise 
you near the axes.

WARNING  Keep clear of the robot and its grippers while it is in motion.
8 Direct Drive Robot Site Preparation and Safety Guide



1   Safety
Electrical hazards
Related information

Electrical hazards

Hazardous-voltage electronics

Hazardous- voltage electronics can be found within the Direct Drive Robot and 
the power supply unit. Under normal operating conditions, you are protected 
from exposure to the hazardous voltage.

Related information

For information about... See...

General safety information “General safety information” on page 2

Safety and regulatory certification “Safety and regulatory certifications” on 
page 3

Emergency stop “Emergency stop” on page 5

High- force hazards “High- force hazards” on page 6

Electrical hazards “Electrical hazards” on page 9

WARNING  Do not try to gain access to the interior of the Direct Drive Robot or its 
power supply. Do not remove panels for any reason. Exposure to the interior electronics of 
the robot or its power supply can cause severe injury.

WARNING Ensure that the power cord and robot cable are in good condition and are 
not frayed. Use of a frayed or damaged power cord and robot cable can cause injury. Use of 
incorrect power cord can cause damage to the robot.

WARNING  Always turn off electrical power and disconnect the power cord before 
installing or servicing the robot.

For information about... See...

General safety information “General safety information” on page 2

Safety and regulatory certification “Safety and regulatory certifications” on 
page 3

Emergency stop “Emergency stop” on page 5

High- force hazards “High- force hazards” on page 6

Mechanical hazards “Mechanical hazards” on page 7
9Direct Drive Robot Site Preparation and Safety Guide



1   Safety
Electrical hazards
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User Guide
2
Specifications

This chapter contains the following topics:

• “Physical dimensions” on page 12

• “Reach and workspace” on page 16

• “Axis and gripper specifications” on page 19

• “Performance specifications” on page 21

• “Mounting specifications” on page 22

• “Electrical requirements” on page 25

• “Environmental requirements” on page 26

• “Computer requirements” on page 27
11
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2   Specifications
Physical dimensions
Physical dimensions

Robot dimensions

Grippers: 6 mm thick titanium, with replaceable rubber gripping pads

Robot cable: 2.4 m (8.0 ft), 1.2 kg (2.6 lb)
 

                                                        

38 cm

85.1 cm
51 cm

Dimension Value

Height 85.1 cm (33.5 in)

Width (home position) 51 cm (20 in)

Depth (home position) 38 cm (15 in)

Weight 31.1 kg (68.5 lb)
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2   Specifications
Physical dimensions
Power supply dimensions

Power supply (G5411-60010)

Power cord: 2 m (6 ft)

Power supply (G5411-60005)

WARNING
HAZARDOUS VOLTAGE.
Contact may cause
electric shock or burn.
Turn off and lock out
system before servicing.

39.5 cm

43.8 cm

13.2 cm

48.3 cm

Dimension Value

Width:

Without mounting bracket

With mounting bracket

43.8 cm (17.3 in)

48.3 cm (19.0 in)

Depth 39.5 cm (15.5 in)

Height 13.2 cm (5.2 in)

Weight 9.7 kg (21.4 lb)

WARNING
HAZARDOUS VOLTAGE.
Contact may cause
electric shock or burn.
Turn off and lock out
system before servicing.

IO

49.6 cm

43.8 cm

14.0 cm

48.3 cm
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2   Specifications
Physical dimensions
Power cord: 2 m (6 ft)
 

Emergency stop pendant dimensions

Emergency stop pendant cable: 2 m (6 ft)
                                                         

Dimension Value

Width

Without mounting bracket

With mounting bracket

43.8 cm (17.3 in)

48.3 cm (19.0 in)

Depth 49.6 cm (19.5 in)

Height 14.0 cm (5.5 in)

Weight 13.8 kg (30.4 lb)

8 cm

13 cm

8 cm

Dimension Value

Width 8 cm (3 in)

Depth 13 cm (5 in)

Height 8 cm (3 in)
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2   Specifications
Physical dimensions
Related information

For information about... See...

Robot reach and workspace “Reach and workspace” on page 16

Axis and gripper specifications “Axis and gripper specifications” on 
page 19

Performance specifications “Performance specifications” on page 21

Mounting specifications “Mounting specifications” on page 22

Electrical requirements “Electrical requirements” on page 25

Computer requirements “Computer requirements” on page 27

Environmental requirements “Environmental requirements” on 
page 26
15Direct Drive Robot Site Preparation and Safety Guide



2   Specifications
Reach and workspace
Reach and workspace

Robot reach

Figure Direct Drive Robot radial reach at 0° wrist angle and vertical reach.

 

Safe zone

The safe zone is the cylindrical region within which the Direct Drive Robot is 
allowed to move without colliding with external devices. In general, the robot 
moves into the safe zone to change its arm orientation, rotate its wrist, or for 
other purposes after it completes a Move to, Pick from, Place to, or Transfer 
command.

A
1

62.5 cm

3.30 cm

48.77 cm

63.5 cm

52.07 cm

Maximum reach Value

Radial reach 
(based on wrist angle)

Center of rotation to center of microplate

0–15°: 63.5 cm (25.0 in)

30°: 61.5 cm (24.2 in)

45°: 58.2 cm (22.9 in)

60°: 54.1 cm (21.3 in)

90°: 45.3 cm (17.8 in)

Vertical reach 
(from attachment surface)

Minimum: 3.30 cm (1.30 in)

Maximum: 52.07 cm (20.50 in)

Highest teachpoint with 0 offset: 
50.39 cm (19.84 in)
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2   Specifications
Reach and workspace
The following diagram shows the top view of the robot safe zone. It is the 
cylindrical region within the dotted line. The radius of the cylinder, measured 
from the center of the base, is 29.1 cm (11.4 in).

Figure Direct Drive Robot safe zone

 

Teachpoint zone

The teachpoint zone is the region within which you can set teachpoints. The 
following diagram shows the top view of the teachpoint zone. The outermost 
dotted line shows the robot’s maximum reach. The cylindrical region within the 
inner circle is the the safe zone. The teachpoint zone is between the two 
boundaries.

Figure Direct Drive Robot teachpoint zone

CAUTION Do not set teachpoints within the safe zone.

29.1 cm

29.1 cm

63.5 cm
17Direct Drive Robot Site Preparation and Safety Guide



2   Specifications
Reach and workspace
 

Caution zone

The caution zone is the thin, doughnut- shaped region surrounding the robot 
waist and base. When the robot moves to and from a teachpoint within this 
zone, the back of its wrist might bump into the waist. To avoid such collisions, 
you can change the position of the teachpoint such that the robot will 
approach or retract from the location using an alternate angle.

The following diagram shows the caution zone. The height of the region is 
measured from the attachment surface to 1.2 cm above the top surface of the 
waist. The radius of the region is 40.6 cm (16 in). These measurements assume 
the use of the standard grippers and teaching jig.

Figure Direct Drive Robot caution zone

 

Related information

40.6 cm

7.8 cm 9.0 cm

For information about... See...

Robot dimensions “Physical dimensions” on page 12

Axis and gripper specifications “Axis and gripper specifications” on 
page 19

Performance specifications “Performance specifications” on page 21

Mounting specifications “Mounting specifications” on page 22

Electrical requirements “Electrical requirements” on page 25

Computer requirements “Computer requirements” on page 27

Environmental requirements “Environmental requirements” on 
page 26
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2   Specifications
Axis and gripper specifications
Axis and gripper specifications

 

Waist

Travel Infinite rotation

Maximum rated torque 362.55 Nm (267.41 lb- ft)

Maximum continuous stall torque 
at temperature rise 75.000 °C

25.74 Nm (18.99 lb- ft)

Maximum velocity 400°/s

Elbow

Travel Infinite rotation

Maximum rated torque 36.68 Nm (5193.73 oz- in)

Maximum continuous stall torque 
at temperature rise 75.000 °C

2.86 Nm (404.61 oz- in)

Maximum velocity 425°/s

Wrist

Travel Infinite rotation

Maximum rated torque 14.23 Nm (2014.90 oz- in)

Maximum continuous stall torque 
at temperature rise 75.000 °C

0.58 Nm (81.73 oz- in)

Maximum velocity 540°/s

Z-axis

Travel 3.30–52.07 cm (1.30–20.50 in)

from the attachment surface

Maximum rated force 420 N (94.4 lb)

Maximum continuous stall force at coil 
temperature 100 °C

120.2 N (27.0 lb)

Maximum velocity 1000 mm/s

Gripper

Travel Closed: 76.5 mm 

Open: 136 mm 

Force 0–2 kg
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2   Specifications
Axis and gripper specifications
Related information

For information about... See...

Robot dimensions “Physical dimensions” on page 12

Robot reach and workspace “Reach and workspace” on page 16

Performance specifications “Performance specifications” on page 21

Mounting specifications “Mounting specifications” on page 22

Electrical requirements “Electrical requirements” on page 25

Computer requirements “Computer requirements” on page 27

Environmental requirements “Environmental requirements” on 
page 26
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2   Specifications
Performance specifications
Performance specifications

 

Related information

Performance

Labware width Minimum: 80 mm (portrait)

Maximum: 133 mm (landscape)

Payload SBS microplates

Full speed: 200 g

Maximum: 500 g

Repeatability x, y, z: ±0.1 mm

Phi: ±0.02°

Transfer time Pick- and- place: < 4 s average

For information about... See...

Robot dimensions “Physical dimensions” on page 12

Robot reach and workspace “Reach and workspace” on page 16

Axis and gripper specifications “Axis and gripper specifications” on 
page 19

Mounting specifications “Mounting specifications” on page 22

Electrical requirements “Electrical requirements” on page 25

Computer requirements “Computer requirements” on page 27

Environmental requirements “Environmental requirements” on 
page 26
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2   Specifications
Mounting specifications
Mounting specifications

Attachment surface

The Direct Drive Robot must be installed vertically on a flat stiff surface that 
is stable. A deformable and non- stable support will greatly reduce the robot’s 
speed and accuracy, and possibly cause errors.

EU installations only. The stable surface recommendation is required so that 
the Direct Drive Robot installation is compliant with the provisions of the 
Machinery Directive 2006/42/EC.

Mounting bolts

Eight bolts are required to hold the Direct Drive Robot to the attachment 
surface. The following diagram shows the base of the robot and the spacing of 
the holes for the bolts.

Figure Direct Drive Robot mounting base

 6.375 mm

30.480 cm

45°

Mounting requirement Measurement

Bolt hole diameter 6.375 mm (0.251 in), through the base

Bolt type M6

Number of bolts 8

Bolt- circle diameter 30.480 cm (12.000 in)

Mounting base – height 0.952 cm (0.375 in)
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2   Specifications
Mounting specifications
Power supply

The power supply has two mounting brackets as the following diagram shows. 
The brackets are 3 rack units (or 3U) in overall height, and permit the power 
supply to be mounted in a standard 19- inch rack.

Figure Direct Drive Robot power supply (front view)

IMPORTANT Because of its weight, Agilent Technologies recommends that you 
mount the power supply at the bottom of the rack. Mounting the power supply 
at the bottom of the rack also facilitates service access.

IMPORTANT If you must mount power supply G5411- 60005 higher in a rack, 
be sure to use additional brackets at the back end to support the weight of the 
power supply. To order the support brackets, contact Automation Solutions 
Customer Service.

To mount the power supply vertically, turn the power supply onto its left side 
only (power switch is on the bottom, indicator lights are on top). When 
mounting the power supply vertically, you can remove the supplied mounting 
brackets and install desired mounting components. To order vertical mounting 
brackets, contact Automation Solutions Customer Service.

The following diagram shows the specifications for the left side of power 
supply G5411- 60010. The holes are M4 x 0.7 screw thread.

Figure Direct Drive Robot power supply (G5411-60010) left side specifications

The following diagram shows the specifications for the left side of power 
supply G5411- 60005. The holes are M4 x 0.7 screw thread.

3 U

CAUTION Air vents are on the left and right sides of the power supply. Be 
sure to provide at least 1.3 cm (0.5 in) of clearance on both sides.

0 cm

1.6 cm 5.4 cm

30.2 cm 34.0 cm

0 cm
1.0 cm

10.7 cm

12.3 cm

35.6 cm

38.3 cm
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2   Specifications
Mounting specifications
Figure Direct Drive Robot power supply (G5411-60005) left side specifications

 

Related information

0 cm 4.4 cm

54.6 cm

57.4

41.3 cm

0 cm

1.5 cm

11.7 cm

13.2 cm

CAUTION Do not block the air vent. Be sure to provide at least 1.3 cm 
(0.5 in) of clearance on the bottom when mounting the power supply 
vertically.

For information about... See...

Robot dimensions “Physical dimensions” on page 12

Robot reach and workspace “Reach and workspace” on page 16

Axis and gripper specifications “Axis and gripper specifications” on 
page 19

Performance specifications “Performance specifications” on page 21

Electrical requirements “Electrical requirements” on page 25

Computer requirements “Computer requirements” on page 27

Environmental requirements “Environmental requirements” on 
page 26
24 Direct Drive Robot Site Preparation and Safety Guide



2   Specifications
Electrical requirements
Electrical requirements

 

Related information

Requirement Value

Voltage 100–240 VAC

Frequency 50/60 Hz

Current 10 A

Power consumption 200 W typical

Fuses • Mains. 2 × 10 A, 250 V, time delay

• Logic power/switch. 2 A, 250 V, time delay 
(only in model G5411- 60005)

• Robot. 4 A, 250 V, time delay

• Emergency stop pendant. 0.8 A, 250 V, time 
delay (only in model G5411- 60005)

Chassis plug IEC 60320 C14

For information about... See...

Robot dimensions “Physical dimensions” on page 12

Robot reach and workspace “Reach and workspace” on page 16

Axis and gripper specifications “Axis and gripper specifications” on 
page 19

Performance specifications “Performance specifications” on page 21

Mounting specifications “Mounting specifications” on page 22

Computer requirements “Computer requirements” on page 27

Environmental requirements “Environmental requirements” on 
page 26
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2   Specifications
Environmental requirements
Environmental requirements

Ambient environment

IMPORTANT The Direct Drive Robot must operate within the temperature and 
humidity specifications stated in the following table.

 

Related information

Operating Recommended range

Temperature 4–40 °C

Humidity 10–90% RH, non- condensing

Storage (non-operating) Recommended range

Temperature - 20–50 °C

Humidity 0–90% RH, non- condensing

For information about... See...

Robot dimensions “Physical dimensions” on page 12

Robot reach and workspace “Reach and workspace” on page 16

Axis and gripper specifications “Axis and gripper specifications” on 
page 19

Performance specifications “Performance specifications” on page 21

Mounting specifications “Mounting specifications” on page 22

Computer requirements “Computer requirements” on page 27

Electrical requirements “Electrical requirements” on page 25
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Computer requirements
Computer requirements

Computer requirements

If your organization uses a computer other than one configured by Agilent 
Technologies, make sure the computer meets the following minimum 
requirements:

• Computer system

– Microsoft Windows XP with Service Pack 3,  
Microsoft Windows Vista with Service Pack 2, or  
Microsoft Windows 7

– 2 GHz or faster 32- bit (x86) processor, multicore preferred

– 2 GB system memory

– 40 GB hard drive capacity with 10 GB free space

– 1280 x 1024 pixel screen resolution

– Microsoft Internet Explorer 6.0 or Mozilla Firefox 1.0 with JavaScript 
enabled (required for using the context- sensitive help and knowledge 
base)

– A PDF viewer, such as Adobe Reader (required for opening the user 
guide PDF files)

• Dedicated 10BaseT or faster Ethernet card (two network cards if 
connecting to your local area network)

Controlling software

VWorks installer 10.0.0.8.21.2009 or later is required.

To facilitate the setup process, a software installation CD is supplied. You can 
use the CD to install the necessary software and setup configurations.
 

Related information

For information about... See...

VWorks software installation 
instructions

VWorks Automation Control Setup 
Guide

VWorks software VWorks Automation Control User 
Guide

Robot dimensions “Physical dimensions” on page 12

Robot reach and workspace “Reach and workspace” on page 16

Axis and gripper specifications “Axis and gripper specifications” on 
page 19

Performance specifications “Performance specifications” on page 21

Mounting specifications “Mounting specifications” on page 22
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2   Specifications
Computer requirements
Environmental requirements “Environmental requirements” on 
page 26

Electrical requirements “Electrical requirements” on page 25

For information about... See...
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